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Logging In
 

· Open Internet Explorer or other appropriate web browser.

Note: Not all versions of all web browsers support the Data Warehouse and it won’t work right. See the list of System Requirements on page 27 to find out if your web browser supports CSDW.  
· Type in the web site address:   https://csdwportal.dhhs.state.nc.us/csdwlogin/
· The Client Services Data Warehouse Log In Page will display.
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+ You may see the following message. Click Yes.





Note that any messages to users will be under “Urgent News” and/or in the “News Archive” box. These messages are normally regarding types of data that did not complete loading the night before. This is rare with Child Welfare data, but is common with NC FAST data. 
· Click the Log In box.
· The Welcome to BusinessObjects page will display.
· Enter your Username and Password.  
· Authentication should be LDAP.


(Your user name and password are you NCID user name and password.)
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· Click Log On.   
· You may see the following message.  Click Yes.
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· The Main Page will display.
Note: From this point forward your screens may not look exactly like the pictures in this guide. That is due to the fact that different users have different program areas they may view within the DataWarehouse and all users have their own way of organizing their personal queries. 
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General Information
Much like Microsoft Word and other programs, there are often multiple ways to do the same thing in the Client Services DataWarehouse. This guide does not attempt to present all the possible alternatives. It simply guides you through one way of locating, running, editing, saving, and sending a previously written State Sanctioned query. The steps using Excel are shown in Excel 2010. They may be slightly different in different versions of Excel. Questions regarding how to use Excel should not be directed to the CSDW help desk or the State Office. 
· The main CSDW page has two tabs; “Home” and “Documents”. These are located in the upper left corner. A setting under Preferences allows you to choose which one of these CSDW opens to when you login. 
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General Information
Main Page

« The main CSDW page has two tabs; “Home" and “Documents”. These are
located in the upper left comer. A setting under Preferences allows you to
choose which one of these CSDW opens to when you login.
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« Queries are stored in folders just lie with Word. There are 2 main folders
already in your DataWarehouee: “My Folders” and “Public Folders"
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« You open folders and subfolders by ciicking the “+* sign next to the folder. This

will open the selected folder and show you the subfolders inside the original one. E
When you click the “+" and it disappears and nothing else happens you have *
reached a folder that has no subfolders. Click on the name of the folder and the ©
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· It is up to the user which page they prefer to see upon logging in. 
· To set your preferences, click on the “Preferences” link and then choose which tab to display upon logging in.
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Itis up to the user which page they prefer to see upon logging in.
To set your preferences, click on the “Preferences” link and then choose which
tab to display upon logging in.

« Users may want to set their preferences based on the way they typically use the
DataWarehouse.

Home Tab
« Ifyou normally use the exaclly same query over and over and not many others,
you may want to set this as your default. This tab displays four “pods” ~ those
include:
o Recently Viewed Documents - shows the most recent queries a user has
viewed.
o InBox — shows the queries in the User's Inbox (clicking on the header
takes you to your inbox).

Documents Tab (recommended)

+ Thistab works like the main screen of the previous version of Data\arehouse-

+ You must be on this tab to access queries you have saved to your personal
folders as well as State Sanctioned queries.
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· Users may want to set their preferences based on the way they typically use the DataWarehouse.

Home Tab

· If you normally use the exactly same query over and over and not many others, you may want to set this as your default. This tab displays five “pods” – those include: 

· Recently Viewed Documents - shows the most recent queries a user has viewed.

· InBox – shows the queries in the User’s Inbox (clicking on the header takes you to your inbox).

Documents Tab (recommended)

· This tab works like the main screen of the previous version of DataWarehouse.

· You must be on this tab to access the complete listing of queries you have saved to your personal folders as well as State Sanctioned queries.

· A screen shot of the Documents tab is shown below. For those who used the previous version of CSDW, this will look somewhat familiar:
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· One important difference between the previous and current CSDW is how Personal and Public Documents are stored. 
· The old CSDW had two folders “My Folders” and “Public Folders”.  [image: image8.jpg]B TiHome,
Smy Folders
i public Folders





               
· This version of CSDW has “drawers” – to get to folders containing documents, you must first open the correct drawer. 

· In the screen shot on the previous page, CSDW opens with the “My Documents” drawer already open. “My Documents” is the equivalent of the old “My Folders”. It is where your inbox lives, as well as any queries you have created or edited and saved.  

· To get to the Public Documents, you must open the “Folders” drawer. The “Folders” drawer is circled in the screen shot on the previous page, and is located near the bottom of the panel.  
· Public Folders are folders containing queries that are accessible to all users with permissions for that Universe.  The queries are organized by division and program area.  
· Different users will have different accesses within DataWarehouse, which means they will see different folders. For example, Child Protective Services workers may not have access to the Economic Services folders (CIP, Energy, FNS), and those workers may not be able to access the Central Registry data. 

· It is up to your county security officer what type of access you will have – some counties may have workers who do both CPS and Economic Services (or at least need access to that data). Access to the different Universes is given via the e-IRAAF form. 

· The final level of folder organization is into Shared and State Sanctioned folders.   
· Shared Folders - contain queries that other users have created and saved here to share with others.  Any user can save queries in the Shared folders. 

Note: You should always exercise caution when using a Shared query. Any user may post queries, and there is no oversight of these queries. It is possible that these queries may not pull precisely the data that the query description claims. Users may look at the filters and conditions to ensure data is being pulled into the results correctly or consult with the CSDW helpdesk.

· State Sanctioned Folders – contain queries that have been sanctioned by Division staff. They have been tested and verified that they in fact retrieve and display the information included in the description of the query. The descriptions of each query will pop up if you hover over the name of the query, and are listed to the right of the query.
· Note: When running a State Sanctioned query, read the description of the query carefully to make sure you understand exactly what the query will be retrieving. 

For example – the query “Monthly Foster Care Caseworker Visit Report” states in the description that it only includes children who were in foster care for the entire month (for our Federal Report we are only required to document visits with children if they were in care for the entire month). So, if Susie was visited on May 15th and 29th, but did not come into foster care until May 6th, the two visits will not show up in the report. The report doesn’t show her two visits because she is filtered out since she was not in care the entire month.
· Open folders and subfolders by clicking the “+” sign next to the folder. This will open the selected folder and show the subfolders within that folder. 
· When you click the “+” and it disappears and nothing else happens you have reached a folder that has no subfolders. 
· Click on the name of the folder and the queries in that folder will display on the right-hand side of the screen. 
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· In the example shown above, the user has navigated from the original Public Folders to DHHS Main Documents, to DSS, to the Child Welfare Universe, then the State Sanctioned folder by clicking the “+” sign (indicated by the purple circles in the screen shot below showing folders that have been opened.)
· There was not a “+” sign on the Central Registry folder (shown with the blue arrow) indicating that there were no subfolders within that folder. 

· When the user clicked on the Central Registry folder, the list of queries in that folder appeared in the pane on the right hand side of the screen. 

Note: In order to protect these queries from accidental alterations, users may edit these queries but cannot save their results in the State Sanctioned folder. Users can open and edit a State Sanctioned query, but must save the edited version into one of their personal folders.  
Running a State Sanctioned Query

· Go to the folder containing the query you want. Select the folder to see the list of queries. 
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· Run your query by double clicking on the name of the query. We will run “Summary of Case Decision Information from Assessments Initiated in a Specified Time Period”. 
· Notice that as you put the mouse over the name of the query, the description pops up so that you can see what information will be retrieved.

Note: For the remainder of the steps in this section we will continue to use this specific query. If you select other queries the following steps may be slightly different (for example you may have different prompts.)
· Prompts - Most State Sanctioned queries will have prompts where you select a specific county and or time frame so that you narrow your results rather than getting statewide results from the beginning of time until the present. When you open the query there will be default values already there. 
· To change the values, click on each prompt and take the appropriate steps to change the values.

· You will need to remove or type over the default values to ensure you are not pulling them as well. 

· In this version of CSDW, for some reason the prompt box opens in such a way that you can’t read the descriptions. As shown in the screen shot on the following page, you can drag the line (indicated by the elongated purple oval) to the right to more fully see the prompt guidelines.
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· If there are only a limited number of possible values (such as county name), click “Refresh Values” and a list of all possible values will appear. Scroll through the list (in this case county names) and select (click to highlight) your county. 
· Click the “>” button to move the desired value to the box on the right. 
· Then highlight the default value and click the “<” button to remove it from the box on the right (otherwise you will get information from that county as well).

· In the example below, we are changing from the default of Wilson to the new county of Guilford.
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· If you are changing a date field, you can delete the old date and type a new one, type directly over the default, or click on the calendar icon to the right of the text box below the prompt. Use the scrolling arrows located at the top left and right corners of the calendar to go to the desired month and year. Click on the desired date. That will overwrite the default.
· In the example below, we are changing the Earliest Investigation Completed Date from 3/1/2014 to 1/1/2014.
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· Complete all the prompts and check to ensure you have entered correct information and removed all defaults.
· Click the “Run Query” button at the bottom right of the Prompt window. Wait for the query to run. 
· Once the results are displayed you have several options of what to do with them. You may view, save, or download to excel to use your data.
Viewing Query Results

Note: Many CSDW queries contain confidential information. This information has been erased from the screen shots, so many of the screen shots in this users guide will show the column headers but no actual confidential data. 
If you simply want to look at your results and do not need to save or download them, you can improve the look of them.

· You can click the “<<” which will close the left pane, allowing you query to display on the entire screen.  
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· You can scroll through your results page by page by using the arrows at the bottom of the screen.
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Downloading Query Results to Excel

· For the majority of query results, you will want to download them to excel. This makes the data much easier to work with. In addition you are then able to share your results via email. 
CAUTION - Many DW queries will contain sensitive private information. Therefore, if you are going to email spreadsheets of the results, you must to password protect the spreadsheet before you send it. Instructions for password protecting a document are included at the end of this section.
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. You will have several options of what format to download. For this guide, we will export to Excel.
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· The “File Download” box will appear. You may choose the “Open” or “Save” button. (It is highly recommended that you save your document.) 
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Working with your Query Document in Excel

Once opened and/or saved in Excel, this document becomes just like any other Excel document and exists completely independently of the DataWarehouse. The following are some suggestions tailored to the use of DataWarehouse query results, but you may do anything to this document you would any Excel document. 

Note: Because this is an excel document at this point, formatting questions are no longer appropriate for the CDSW helpdesk. If you want to learn how to freeze panes, insert formulas, etc. those types of questions should be directed at someone you know with knowledge of Excel rather than the CSDW helpdesk or State DSS staff.

Changing how you view your report

Changing column width
· You can make columns wider or narrower by double clicking (and Excel will do it for you), or by dragging the mouse.
· In the screen shot below, some of the column headers (highlighted in blue) are cut off so that the entire text is not showing. This is because the cells are too short.  You can have Excel automatically resize it to include all the words by putting the mouse on the line between the box that says “4” and the box that says “5” and double clicking. You know the mouse is in the correct position when it turns into a cross looking thing. 
· You can also put the mouse on those lines and manually drag to make the column height taller or shorter than they are to start with. 
· Column K, Case Decision Date is showing all ####. This is because when a column is too narrow to display a date, it will show ####. If you make the column wider (by either of the two methods listed above, the dates will show in proper format).
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Freezing Panes

· This allows you to lock (or Freeze) the header or other rows at the top of the document so that you are able to scroll through the others while still seeing the column headers. 
· Select the row underneath the row(s) you want frozen (by highlighting the entire row – click in the number to the left – in the screen shot below, this is the cell with the “5” in it indicated by the arrow)
· Go to the “View” tab on the Excel ribbon and click the dropdown arrow next to “Freeze Panes”. Click on the “Freeze Panes” option highlighted in the screen shot. If you later want to unfreeze, go back the “Freeze Panes” icon – if panes are already frozen, the menu will say “Unfreeze Panes.”
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Printing
· If you are going to print your report, you will want to format the document for better printing. Some queries will have too many columns to print well, even shrinking the text size and using landscape. However, many can be shrunk a bit and will fit across a single sheet if it is changed to landscape.

· To custom fit a query to landscaped page go to the “Page Layout” tab on the ribbon. Select the dropdown menu under “Margins”, and select “Custom Margins.”

· In the Page Setup Menu click the radio button next to “Landscape”
· In the Scaling section, click the radio button next to “Fit to” and leave the “1” next to “page(s) wide” but delete the “1” next to “tall.” 
· Then click “ok” at the bottom of the Page Setup Menu. This will make your report one page wide and however many pages long as necessary. 
· To check to see if the text will be too small, after clicking “OK” you can navigate to the Page Setup Menu again and see what size the text is printing. If it is too small, you won’t be able to print all of your results on letter sized paper. 
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Emailing your document

· You can attach the spreadsheet to email just as you would with any other document, however many (although not all) spreadsheets that come from a DataWarehouse query contain confidential information and therefore must be password protected to ensure confidentiality. (For example, a child’s name is confidential, a SIS ID number with no name is not. If in doubt, assume it should be password protected.
· To password protect a document, go to the “File” tab on the ribbon, Select “Info”, then the dropdown arrow on the “Protect Workbook” icon, and finally “Encrypt with Password.”
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· You will see a screen that looks like this: type your password where you see the asterisks – then save the file (it will ask you for the password again to confirm it)

[image: image27.png]WE9-ODEVEAEIT

DW Basic training version 2 draft 6.18.14 .doc [Compatibility Mode] - Microsoft Word

c@REHI-C-DERVHNGES

- @ Home insert

% cut

sl q # Find -

e R Cop
€ Fommat painter
Cipboars

Al c2 AN A B e
2. Replace
B I U-sex x| [ W-A- s seea-

Font 5 Editing

Emalling_your document
+ You can attach the spreadsheet to email just as you would with any other
document, however many (although not all) spreadsheets that come from a
DataWarehouse query contain confidential information and therefore must be
password protected to ensure confidentiality. (For example. a child’s name is
confidential. a SIS 1D number with no name is not. Ifin doubt, assume it should
be password protected

To password protect a document, go to the *File” tab on the ribbon, Select “Info”,
then the dropdown arrow on the “Protect Workbook” icon, and finally “Encrypt
with Password."

Information about Summary
et weltvves st

s grerss depefi)
A e

g e

+ You will see a screen that looks like this: type your password where you see the
asterisks — then save the file (it will ask you for the password again to confirm it)

o sme
B smeas
25 Open
& Close

Recent
New
print
Save & Send

Help

3 options

B et

Pagelayout  Formulas  Data  Review  View

Summary_of_Case_Decision_Information_from_Assessments Initiated_in_a_Specified_Time_Period[1]ds [Compatibilty Mode] - Microsoft Excel

o@ R
6@ @ R

Information about Summary_of_Case_Decision_Informati
CA\Users\HBOHANAN\ AppDatalLocal\Microsoft\Windows\Temporary Iternet Files\ Content IES\S.

Compatibility Mode

@ Some new festures are disablel o preent problems when working with
previous versions of Office. Converting this file will enable these features, but
Comvert | mayresultin layout changes.
Properties -
Permissions s
rags
Protect Gategories
Workbook -
D Related Dates
Last Moditied
Prepare for Sharing Created

Before sharing this fil, be aware that it FEEEGE—TFSw—
' Document properties, printer path

CReCkTOr | Content that cannot b checkeo
et tiepe
Versions
L ——
Vonage
=

74.5K8
Add a title
Addatag
Add a category

Today, 242 PM
Never
Today, 204 PM

Add an author
HEATHER BOHANAN





Note: If you forget your password you will not be able to access this document again, even on your own computer as the creator of the document. There is no one you can call to get it - it will be locked forever!!! 
· You may send the recipient of your password protected spreadsheet the password in a separate email, or call them and give them the password.
Using Queries in Your Own Personal Folders

When you first logged on, folders and how they worked were discussed under “General Information”. So far we have only gone into Public Folders. Now we will use the “My Folders” Section. This will look different for everyone, but the general principles will be the same.

Copying a State Sanctioned Query to your Personal Folders
· If there is a particular query that you will be running regularly, you may want to save a copy in your personal folders. This will allow you to tweak the query somewhat so that a) there are not quite as many steps to running it each time and b) you may be able to eliminate fields from the query that you don’t want, making it simpler to use.
· From the page showing all the State Sanctioned queries in a particular folder, select the one you wish to copy by right clicking on it. That will cause a pop-up box to come up. Select “Organize” and then “Copy” from the second pop-up menu. When you click “Copy” the pop-up menus will disappear.
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· Next you will navigate to your personal folders create a new folder to paste a copy of the query into. Recall that folders are organized in “drawers” and the State Sanctioned ones are in the “Folders” drawer. User’s personal folders are in the “My Documents” drawer (located directly above the “Folders” drawer.)
· Open the “My Documents” drawer, click on “My Favorites” and then click the dropdown box next to “New”. Select “Folder”. You will be prompted to type a name for the new folder. Then click “OK”
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· Once you have created the folder, it will show under the “My Favorites” folder.

· Then select the folder, by right clicking on it. That will cause a pop-up box to come up. Select “Organize” and then “Paste” from the second pop-up menu. When you click “Paste” the pop-up menus will disappear and your query will show in the pane to the right of your folder list.
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· Once you have the query in your personal folder, you might want to change the title or the description a little bit. 

· I recommend that any time you save a state sanctioned query to your own folder, changing the name just enough that you will never get confused if you are using the state sanctioned one, or your own. 
· I also recommend you not delete any of the description (so that you still know what the query is pulling), but you may want to add to it. 
· To change the title or description, right click on the query to select it, and select “Properties” from the drop down menu.
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· The Properties window will open and you can edit the title or description. When satisfied with the changes, click “Save and Close” in the lower right corner. (I added “Guilford County” to the title of the query.)
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Retrieving and Running a Query Saved to Your Folders
· The folders and queries in “My Favorites” operate in the same way as the queries in Public folders. You access and run the queries the same way. (See “Running a State Sanctioned Query” on page 7 for instructions on how to run a query.)

· However, now that you have saved a query into your personal folders, you can edit it to customize it to your personal needs and preferences.
Editing a Query 
· You can edit any part of a CSDW query to make the query more user friendly to your needs. This includes the filters, the results, and the title. In this beginners guide, we are only showing how to edit a filter.

Note: Many of the State Sanctioned queries have the phrase “in a Specified Time Period” in the title. This is because they are designed to be run for any length of time the user desires. I do not recommend changing the title in the CSDW to include specific dates, because the changes to the title will be saved to one particular date range, and when you run the query at a later time, you will likely be using different dates. I recommend that you insert actual dates in the title only after exporting to Excel.
Filters vs. Results
· The quick and dirty way that DataWarehouse works is that it goes in whatever system (Central Registry, MRS, SIS, etc.) you have told it to, and it looks at all the data in there. You use the “Filters” to tell it what data to filter out of the entire dataset. In other words, it will only bring back records that meet those conditions. But you don’t want to see every single piece of data attached to that record (that is a lot of data and you probably don’t care about it all anyway!) so, you tell it only the pieces you want to see. Those selected records you want to see are the “Results”.

Changing a Prompt to a Constant

· When these queries are set up we write them so that each time a user opens them the query “prompts” them to select a county and a time period. This way anyone in the state can use them. However, if you are a Program Manager, odds are you are only interested in your county’s data, so it’s a pain to have to select your county every single time you run the query. So, we are going to change the query so that it automatically pulls up your county. (In this example, we are Guilford county.)

· To edit a query, right click on the query to select it, and select “Modify” from the drop down menu. The CSDW will take a moment to return your query. You will need to complete all the prompts, just like you did when it was State Sanctioned and hit “Run Query”(remember, right now this is the exact same query, we haven’t changed it yet.)
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· You will see the following screen. Notice the results are still displayed but to the left are the data elements (called Available Objects) from your query and there are a bunch of tabs on the toolbar. 
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· The Available Objects are the data elements that are a part of your results. Most of the time each Available Object represents a column of data. 

· The Tabs at the top will allow you to Edit the query as well as perform advanced functions not demonstrated in this Users Guide. 
· To Edit the query so that we don’t have to enter “Guilford” and delete “Wilson” every time we run it, click the Data Access Tab, then click “Edit”.
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· The Query Panel will open up. You can make it easier to view by closing the Data Preview panel at the bottom by clicking on the “Data Preview” button. You can also drag the entire Panel and expand it by dragging the dots at the bottom of the screen. (These are both difficult to see in the screen shot below, but the arrows indicate where the items are on your screen.)
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· Notice that in the filter for “County Name” it says “Enter Value for County”. If you click on the arrow at the end of that row, “Prompt” will be highlighted. This is what makes the query prompt you each time for the county name.
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· Click “Value(s) from list” and a list of counties will appear (just like it did when you were selecting them using the prompt). In the same way you did when selecting a county using the prompt, (highlighting and using the “>” arrow), select your county, move it to the right panel, and click “OK” at the bottom. Then your filter should say “Guilford”.
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· Click “Run Query” at the top of the panel. You are no longer prompted for the county. 
· You will still be prompted for dates. You probably want to leave the dates as prompts as you will want to run the query for different dates at various times. 
Removing Data Elements (Columns)

· State Sanctioned queries are written to be as helpful as possible to the largest number of users. However, that means that there may be data elements within the query that you personally do not need and they may be distracting to you when viewing and using your results. You can remove these unwanted data elements (columns).

· There are several ways to remove unwanted data. The first, and easiest, is to leave the query itself unaltered, and simply delete the column when you export to excel. 
· The second is to delete the column from the report displayed in the CSDW.  

· If you right click in the column of data (not the header), the entire column of data will be selected, and the popup window will display. Select “Delete” and the selected column will be deleted. 
· If you right click the header (in this case the blue box with “Race”), the same popup will display, but when you select “Delete” you will be asked if you want to delete the row or the column. Row will be selected by default, and you want to be sure not to delete the row, that will remove all your headers on your report. Since this method involves an extra step, and allows you to accidentally delete your entire header row, I recommend you delete by selecting the actual column of data. 
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· When you delete from the report display, you have not removed the data element from the query, so you can add it back if you change your mind. 

· If you later decide to add the data element back into your report, click on the data element from the “Available Objects” panel, and drag it to the edge of the cell that you want it to precede. (Once you click on the data element, keep your mouse pressed down until you are ready to release it into the report.)

· Ensure that the highlighted rectangle goes along the vertical edge of the cell and that you see the data element you are moving back “hovering”. Release your mouse and the data element will populate back into your report.

· In the example below, I took “Race” and put in back into the report, just before the Child SIS ID column. 
· This does get a bit tricky sometimes, so if you end up releasing the data elements somewhere you do not want, you can use the “undo” button located at the top left of the screen and try again. 
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Saving an Edited Query
· When you are satisfied with the edited report you will need to save the change(s). To save your edited query, click the dropdown arrow next to the disk icon. 

· “Save” will save it to the same folder it was in, with the same name.
· “Save As” will require you to navigate to a new folder and gives you the option of changing the name and description. 
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· Once you have saved it, if you want to go back into “Favorites” and open the query, you will see that you are only prompted for the dates. 
Sending a Query to other DataWarehouse Users
If you have a query just the way you want it, you may want to send it to other users (such as your program managers) so that they can run it. You may send a query to anyone who has a valid user id for DataWarehouse. Queries are sent within CSDW, and users must login to retrieve them. (Although it appears there is an option to send them via email, you cannot actually do that.)
· To send a query, navigate to the query location, right click to select the query, select “Send” and “BI Inbox”
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· A panel will display, and you can search for the person you want to send the query to. Make sure “User List” is highlighted. Type the name in the “Find Title” box and click the binoculars. When the name displays, click to select it, and use the “>” arrow to move the name to the “Selected Recipients box”. 
· Leave “Send As” defaulted to “Copy” 
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· You may send the query to multiple people at the same time. Search them individually and send them over until all your recipients are listed in the recipient box. Then click “Send” at the bottom right of the screen.
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Logging Off
· When you have finished with DataWarehouse you should actually log off, rather than just closing (or minimizing your Internet application) as there is confidential information in the DataWarehouse.

· Click “Log Off” on the top right corner of the page.
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Contact Information

If you are having issues, or have questions, the nature of your question should determine who you contact. Before contacting anyone, you should review the Frequently Asked Questions to ensure your issue is not addressed there. 

· If you are having technical difficulties with the CSDW application itself (you can log on but then it doesn’t work right) – contract the CSDW help desk at (919) 855-3200 option #2. 

· A suggestion before contacting them is to try to log in to CSDW on another machine at your agency. If you still have the problem, then you know it is something connected to your personal access. If the problem doesn’t happen on another machine, then it is somehow related to your PC, and you should contact your county IT resource. 

· If your application runs correctly but you want to know how to do something, or you don’t understand something in this Users Guide, you can contact your CPR, or the Data Management Team (Heather). Heather can be reached at: (919) 527-6264 or Heather.Bohanan@dhhs.nc.gov. 

Frequently Asked Questions

1. I can’t open my folders!

When opening folders, click on the “+” sign to the left of the folder, not the actual folder icon or name of the folder. When you click on the “+” and it disappears, this means there are no more subfolder and then you can click on the name of the folder and it will open. 

2. I can’t save my query! When I try to save it, the “Save” feature is grayed out.
You are probably working with a State Sanctioned query. You cannot save those to their original location – otherwise everyone would be “unsanctioning” those queries. You can use the “Save As” feature and save your changes in your personal folders though.  

3. I don’t know exactly what is wrong with my results, but they don’t look like I though they would. Stuff I think should be showing is missing, and it’s just a little, well, “off”.
Make sure you know what the query you are running will give you, and that this data is what you are looking for. Different queries pull different data, sometimes with only a slight difference. if you are not sure, contact someone from the Division or the CSDW helpdesk. 

(For example, the query: Monthly Foster Care Caseworker Visit Report for Select Month  has the following description “Shows only children 18 and under in custody for the entire specified month with visit date and location (if visits have occurred). Excludes ICPC children placed in NC.” Therefore it only pulls data from children who were in Foster Care the entire month. So if child came into care on the 2nd of the month, and you run this query, they will not show in the results.)
4. I am getting an error message: “No data to retrieve”.

You have created a set of queries and filters that do not match with any records. This could be because in fact, there is no data that meets the conditions you are looking for, or, more likely you have done something when editing the query that makes it “mess up” – such as putting in dates incorrectly so that the begin date is later than the end date. 

5. When I run my query it is not showing things that I know are in the source system (MRS, Central Registry, etc.)
There are a couple of possible reasons for this:

a) Have you actually been in the source system and checked to see that it is there? If not, please check it.

b) Data only loads into the DataWarehouse at night. If you ran a query in the morning, realized there was missing data, keyed all day and ran another query in the afternoon, the query you run in the afternoon will not reflect the data that was keyed that day – it will look just like the one you ran in the morning, you will have to wait until the following day for that day’s data entry to show.

c) Are you sure the query that you are running is actually pulling what you think it is pulling? Read the description of the query closely, and if you are still not sure, contact someone from the Division or the CSDW helpdesk. 

(For example, the query: Monthly Foster Care Caseworker Visit Report for Select Month  has the following description “Shows only children 18 and under in custody for the entire specified month with visit date and location (if visits have occurred). Excludes ICPC children placed in NC.”

Therefore it only pulls data from children who were in Foster Care the entire month. So if child came into care on the 2nd of the month, and you run this query, they will not show in the results.)
6. Mine doesn’t work exactly right (when I close out of a query, it logs me out, I can’t edit a query, assorted things like that).

I have no idea why, but some users have had this based on the ISP they are using. Try another one (such as Chrome or Firefox if you have been using IE). I don’t know why this solves some problems, but it does. 

System Requirements
Current System Requirements for using Client Services DataWarehouse are located on the “User Tools and Information” page of the CSDW.
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Questions about System Requirements should be directed to your county IT resource.

 
As of June 2014, those requirements are:

Hardware: 
· Minimum Screen Resolution:

Screen resolution of [1024] x [768] is recommended

· Minimum Hardware Requirements:

 

2 processors with minimum 2 GHz recommended, &
4 GB RAM Recommended

· Recommended Disk Space Requirements
5 GB for default installation with English language only installed

8 GB for default installation with all languages

 

Operating Systems:
· Windows XP SP3
· Windows Vista 32 bit and 64 bit
· Windows 7 32 bit and 64 bit 
Internet Browsers (32 but & 64 bit):
· MS IE 6, 7, 8, 9 & 10 (compatibility mode)
· FireFox 18 & up
· Safari 5.1 & up 
Java JRE (32 but & 64 bit):
· 1.6.0_45 for R2.
· 1.7.0_40 up for R4. 
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